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感谢您选择英创的 ARM9 系列嵌入式模块产品。 

 

为了让您能够尽快地使用好我们的嵌入式模块，英创公司编写了这篇《使用必读》，我

们建议每一位使用英创 ARM9 产品的客户都浏览一遍。我们本着通俗易懂的原则，按照由

浅入深的顺序，采用了大量的图片和浅显的文字，以便于客户能边了解、边动手，轻松愉快

地完成产品的开发。 

 

在开发和使用英创嵌入式模块的过程中，如果您遇到难题，需要帮助，您可以通过以下

三种方式寻求英创工程师的技术支持。 

 

1、直接致电 028-86180660  85140028  85137442  85136173 

2、技术支持邮件 support@emtronix.com.cn 

3、登录 http://www.emtronix.com，在技术论坛上直接提问 

 

再次谢谢您的支持！ 
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1  搭建硬件开发平台 

 

1.1  必要的准备 
新客户最初购买的第一套英创 ARM9 嵌入式模块产品往往包括该型号的嵌入式模块基

本开发套件，这套开发套件包括： 

 一块该型号的嵌入式模块，如 EM9260 

 一块与该型号嵌入式模块配套的开发评估底板 

 一条串口连接线 

 一条以太网口连接线 

 一条直流电源线 

 一张开发资料光盘 

 Microsoft 公司的 Windows CE core 的正版授权标贴 

 

英创嵌入式模块两侧有双排插针，这两排插针将嵌入式模块的板载接口资源引出，而开

发评估底板上安装有相对应的接口插座，因此，嵌入式模块就象一个大芯片一样对插在与该

嵌入式模块相配套的开发评估底板上，从而形成一套较完整的开发系统。 

 

新客户要在英创嵌入式模块开发套件的基础上进行进一步的开发，需要作如下一些必要

准备： 

 准备一台具有+5V 电压输出的普通直流稳压电源或开关直流电源（+5V±5%），将

英创提供的直流电源线正确地连接到该电源的+5V 输出上（注意极性） 

注：如客户需进行 GPRS/CDMA 应用开发，由于 GPRS/CDMA 通讯模块发射的

瞬间电流可达 2A，建议在选择开关电源时选输出功率在 10W 以上的。 

 准备一台带以太网接口和至少一个 RS232 串口的 PC 机作为开发主机，该 PC 机

安装 Windows XP 操作系统 

 用户应当拥有一个能让嵌入式模块模块和开发主机接入的以太网络 

 尽管不是必需的，但为了加快开发进度，建议客户准备一块低成本单色 LCD 模块，

目前 EM9260 可自动支持三种常用的 LCD 模块：（1）128×64，KS0108 控制器；

（2）320×240，SED1335 控制器；（3）240×128，T6963C 控制器。第一次使

用 EM9260 的客户也可以从英创公司购买需要的 LCD 模块。对最终不需要 LCD

的应用，开发完成后只需简单去掉 LCD 即可，并不影响应用程序运行。 

 一只可供临时存储数据的 U 盘 
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根据客户所开发的产品不同的需求，除了以上一些客户开发的必要配备外，客户可能还

有一些其它开发附件，如： 

 英创提供的其它配套模块产品，如 AD 模块、IO 扩展模块等 

 GPRS/CDMA 通讯模块（如：Siemens MC39i）以及天线等附件 

 SD 存储卡 

 客户所需要的其它附件 

这些附件的配套使用方法，客户请参考该产品的使用说明或手册。 

 

1.2  开发环境的硬件连接和安装 
在以上条件准备好以后，就可以进行开发环境的硬件连接了。 

标准配置的英创 ARM9 嵌入式模块板上配有内存和 Flash 电子盘，并内置了正版

Windows CE 操作系统，客户在开发主机上使用 eVC 开发应用程序，并通过以太网和英创

嵌入式模块进行连接、传输和调试。 

嵌入式模块配套开发评估底板上往往包括了 GPRS 无线通讯接口单元、RS485 单元、

RS232 插座等连接器件、LCD 接口、矩阵键盘接口、USB 接口和以太网络接口等，这些接

口直接面向用户，在相关文档中将详细讲解底板提供的硬件接口的功能和用法。开发评估底

板不仅可以方便开发者的线缆连接，同时在开发光盘上提供的原理图和 PCB 图还可以为开

发者进行外围电路设计时提供一定的参考，以便开发者在此基础上进行增加或者删减电路单

元，重新进行适合自己产品需求的定位，快速地构成自己的应用产品。 

嵌入式模块有两种工作模式：运行模式和调试模式。请注意，开发评估底板上有一颗可

在运行模式和调试模式之间进行切换的跳线 JP1，若该跳线器断开，系统将进入正常运行模

式；短接时，系统将以调试模式启动，如图 1-1。客户在进行开发调试时，总是让嵌入式模

块处于调试模式，即 JP1 处于短接状态。在正常进行调试或运行应用程序之前，客户还需

要通过编辑两个应用文本文件（dbginfo.txt / userinfo.txt）来对系统进行软件通讯配置（具

体配置方法将在后文进行交代）。 

 
图 1-1  JP1，模式切换跳线器 
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将开发主机接入以太网络。同时，将英创嵌入式网络模块也接入以太网，如图 1-2。这

样开发主机和嵌入式模块就能够建立起网络连接。 

 
图 1-2  将 EM9260 评估系统接入以太网 

 

若已准备了 LCD 模块，可从评估地板 CN6 插座接入 LCD 模块，EM9260 可自动支持

三种内嵌控制器的单色低成本 LCD 模块：（1）128×64，KS0108 控制器；（2）320×240，

SED1335 控制器；（3）240×128，T6963C 控制器。EM9260 的 SDK 包含了对这些 LCD

模块进行基本操作的 API 函数，如字符、汉字显示等。 

 
图 1-3  将 LCD 模块接入评估底板 
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至此使 EM9260 运行的基本硬件环境已搭建完成。如图 1-4 所示。 

 

图 1-4  基本硬件连接 

 

现在可以给嵌入式模块进行通电，即将 5V 直流电源线接头插入嵌入式模块配套底板上

的电源插头（注意正负方向），见图 1-5，此时，嵌入式模块上的橙色电源 LED 指示灯亮。 

 
图 1-5  开发系统上电 

若系统配有 LCD 模块，上电后，LCD 屏将很快显示如下画面： 

 

图 1-6  支持单色 LCD 显示的 ARM9 模块启动界面 

 

在运行状态，系统启动约需 8 秒钟，系统启动后，将显示欢迎画面，如图 1-7 所示，表

示系统启动成功，已可运行用户的应用程序或已进入调试状态。 

 

图 1-9  支持单色 LCD 显示的 ARM9 模块启动成功界面 
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2  工作模式选择 

 

2.1  工作模式介绍 

英创 ARM9 嵌入式模块有两种工作模式：调试模式和运行模式。在配置软件开发环境

之前，用户需要对这两种工作模式有所了解，以便于进行应用开发。 

调试模式是指开机以后系统处于调试状态，此时用户可以通过 eVC 及其远程调试工具

来操作英创模块，实现应用程序下载调试、文件管理等功能。在开发阶段，系统总是处于这

种状态下。 

运行模式是指开机以后系统自动开始执行用户指定的程序。开发完成，进入实际应用时

系统总是处于这种状态下。 

英创 ARM9 嵌入式模块工作于上述的哪一种模式，是通过开发底板上的跳线器 JP1 来

选择的（JP1 在评估底板的具体位置见图 1-1）。JP1 短接，则工作于调试模式；JP1 断开，

则工作于运行模式。 

 

2.2  系统配置文件说明 

除设置跳线器以外，用户还需要修改两个重要的文件 dbginfo.txt 和 userinfo.txt 来为

系统的调试/运行配置必要的参数。 

 

2.2.1  dbginfo.txt 

dbginfo.txt 所保存的是在调试状态下目标机和开发主机的网络参数，要对系统进行开发

调试，则必须事先将该文件编辑完成并存于英创模块的“NandFLASH”目录中。其内容及

格式如下（双斜线后的蓝色部分为加注的说明文字，并不包括在文件中）： 

[LOCAL_MACHINE]              //目标机信息 

DefaultGateway="192.168.201.8"  //默认网关，根据用户所在网络的实际设置填写。

如果填为 0.0.0.0，则表示保留原有的配置 

IPAddress="192.168.201.205"     //目标机 IP 地址，由用户自行设置 

SubnetMask="255.255.255.0"     //子网掩码，根据用户所在网络的实际设置填写 

[HOST_MACHINE]               //开发主机信息 

IPAddress="192.168.201.4"       //开发主机 IP 地址，根据用户主机的实际设置填写 
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port="9300"                     //端口号，采用默认值 9300，不能修改 

[SYSTEM]                      //存储空间调整 

Store="50"                      //系统文件和用户文件各占用 50%的存储空间（注） 

编辑好 dbginfo.txt 并存入 U 盘，将 U 盘接在开发底板的 USB 接口上，短接 JP1，然

后上电启动，系统自动会把这个文件存入到“NandFLASH”目录中，并读取其内容作为默

认配置。如果用户的调试环境网络参数没有改变，则今后上电启动的时候无需再接 U 盘，

调试启动时，系统将从“NandFLASH”目录读取配置参数。如果网络参数发生了变化，则

用户应该按照新的参数修改 dbginfo.txt，并再次通过 U 盘把这个文件复制到系统的

“NandFLASH”目录中，以此让系统接收新的配置。 

注：Store 用于分配存储空间，双引号中间的数字表示系统文件占用的存储空间百分比。

英创公司出厂默认将 NorFLASH 均分给系统和用户（即各占 50%），用户可以通

过设置该参数调节这一比例以适应自己的需求。例如，用户程序需要占用 70%的

存储空间，则应该如下设置：Store="30"。该参数的有效范围在 10-90，小于 10

或者大于 90 的设置将视为无效操作，此时系统采用默认配置。 

 

2.2.2  userinfo.txt 

userinfo.txt所保存的是在运行状态下目标机的网络参数和开机自动运行的程序的参数，

要让系统开机自动运行应用程序，则必须事先将该文件编辑完成并存于英创模块的

“NandFLASH”目录中。其内容及格式如下（双斜线后的蓝色部分为加注的说明文字，并

不包括在文件中）： 

[LOCAL_MACHINE]              //目标机信息 

DefaultGateway="192.168.201.8"  //默认网关，根据所在的实际运行网络来设置。该

网关地址与 dbginfo.txt 中的设置不一定相同 

IPAddress="192.168.201.205"     //目标机 IP 地址，由用户自行设置。该 IP 地址与

dbginfo.txt 中的设置不一定相同 

SubnetMask="255.255.255.0"     //子网掩码，根据所在的实际运行网络填写，该子

网掩码与 dbginfo.txt 中的设置不一定相同 

[USER_EXE]                    //用户程序信息 

Name="serialtest.exe"            //系统开机自动执行的程序，默认为 serialtest.exe。

实际开发完成以后用户将自己的应用程序文件名
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填在双引号之间取代目前的默认文件名，开机即

可自动运行（注） 

Parameters="COM1 9600"      //系统开机自动执行的程序的参数配置。此处为

serialtest.exe 的参数：测试 COM1，波特率为

9600。开发完成以后在此处填入实际应用程序的

参数，如果没有则不填，但必须保留双引号 

[SYSTEM]                      //存储空间调整 

Store="50"                      //系统文件和用户文件各占用 50%的存储空间（注） 

 

注：1、程序“serialtest.exe”是存放于 WinCE 默认的系统文件夹下面，故此处没有

指定其存放位置；而实际的用户应用程序总是放在系统的“NandFLASH”目

录当中，因此用户在编辑 userinfo.txt 的时候应该指定应用程序的位置，即

“Name”属性应该如下所示（此处以 userapp.exe 为例）： 

     Name="\NandFLASH\userapp.exe" 

2、Store 参数的含义及使用方法同 userinfo.txt。 

 

编辑好 userinfo.txt，将开发主机与英创 ARM9 嵌入式模块建立连接，通过 eVC 将该文

件以及文件中所指定的应用程序复制到“NandFLASH”目录当中（建立连接以及文件复制

的方法见后文），接下来断开 JP1，然后上电启动，系统会读取 userinfo.txt 中的内容作为默

认配置，并按照该文件的设置运行指定应用程序。如果用户需要修改应用程序，则可以按照

新的参数修改 userinfo.txt，并再次通过 eVC 把这个文件以及新的应用程序复制到系统的

“NandFLASH”目录中，以此让系统接收新的配置。 

注：1、如果只是程序本身发生变化而网络参数、程序名字和参数均不变，则无需修改

此文件。 

2、如果仅仅是开发调试阶段，则无需编辑 userinfo.txt。 
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3  软件开发环境的安装和配置 

 

英创公司的 ARM9 系列模块（包括 EM9000 和 EM9260），支持微软公司的 eVC 进行

应用程序的开发。eVC 是微软针对嵌入式系统提供的一套功能完善且可免费获取的开发工

具，与 PC 平台通用的 VC 保持了高度的一致性，同时考虑 C/C++的执行效率，因此 eVC

被作为 EM9260 应用程序开发的首选工具。本节将介绍 eVC 的安装过程以及软件开发环境

的搭建，对所有的英创公司的 ARM9 模块，eVC 和 EM9260 的安装都是一样的，以下将以

EM9260 为例介绍 eVC 及 SDK 的安装。所需的软件均包括在开发光盘的“eVC 安装”和

“SOFTWARE”目录下。 

 

3.1  eVC4 和 eVCsp4 的安装 

1、在安装 eVC 之前，用户首先需要安装 Microsoft .NET Framework 1.1。运行“eVC

安装/Dotnetfx”目录下的 Dotnetfx.exe，到出现如图 3-1 所示的许可协议对话框，选择 同

意 并安装。 

 

图 3-1  同意 Microsoft .NET Framework 1.1 许可协议 
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2、.NET Framework 1.1 的安装过程如图 3-2 所示。 

 

图 3-2  Microsoft .NET Framework 1.1 安装过程 

 

3、.NET Framework 1.1 安装完毕以后就可以进行 eVC4.0 的安装。运行“eVC 安装

/eVC4”目录下的 setup.exe，系统自动载入相关信息，过程中全部直接 next，使用系统默

认的设置，至出现如图 3-3 所示的许可协议对话框，选择 I accept the agreement，同意安

装协议。 

 
图 3-3  同意 eVC4.0 安装协议 
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4、接下来将出现序列号对话框，打开“eVC 安装/key”文件夹，将文件中的序列号填

入，如图 3-4。 

 
图 3-4  填写安装序列号 

 

5、在安装项目选择中去除 Standard SDK for Windows CE .NET，如图 3-5。 

 
图 3-5  去除 WinCE 的标准 SDK 
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6、系统提示安装 Windows CE Platform Manager，确认安装，如图 3-6。 

 
图 3-6  确认安装 WinCE Platform Manager 

 

7、WinCE Platform Manager 的安装过程如图 3-7。 

 

图 3-7  安装 WinCE Platform Manager 

 

8、安装完毕以后，系统会提示关闭所有的应用程序，选择 Continue，如图 3-8，并在

接下来的几个对话框中均选择 OK。 

 
图 3-8  确认关闭应用程序 
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9、接下来出现安装确认对话框如图 3-9，不作任何修改，直接确认安装（建议客户不

要修改默认的安装路径，以免今后使用时出现错误）。 

 

图 3-9  确认安装信息 

 

10、系统开始安装 eVC4.0，如图 3-10。 

 
图 3-10  eVC4.0 安装过程 

 

 

 

 

 

 



英创信息技术有限公司                                    英创嵌入式模块 EM9260 使用必读 V1.01 

www.emtronix.com                                                              028-86180660 16

11、eVC4.0 安装完成以后，即可安装 eVC4sp4。运行“eVC 安装/eVCsp4”目录下的

setup.exe，至如图 3-11 所示的许可协议对话框，选择 I accept the terms in the License 

Agreement，同意安装协议。 

 

图 3-11  同意 sp4 安装协议 

 

12、系统开始安装 sp4，如图 3-12。 

 

图 3-12  安装 sp4 
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13、sp4 安装完成以后，运行“SOFTWARE/SDK”目录下包含的所购模块的 SDK 安

装程序，本文以 EM9260_SDK.msi 为例。至出现如图 3-13 所示对话框，选择 Accept，同

意安装协议。 

 

图 3-13  同意 SDK 安装协议 
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14、出现如图 3-14 的对话框时选择 Complete。 

 

图 3-14  选择完全安装 

15、安装过程如图 3-15。完毕以后，需要的软件即全部安装完成。 

 

图 3-15  SDK 安装过程 
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3.2  软件开发环境的配置 

1、安装完成上述软件以后。打开“SOFTWARE/config”目录，将里面的 dbginfo.txt

复制到本地硬盘，并根据用户所在的网络修改其内容（关于这个文件的说明见第二章）。 

以笔者的开发环境为例。本地网关为 192.168.201.8；开发主机的 IP 地址为

192.168.201.4；子网掩码为 255.255.255.0；为英创 ARM9 嵌入式模块分配的 IP 地址为

192.168.201.205。 

则 dbginfo.txt 文件的内容应编辑如下： 

[LOCAL_MACHINE] 

DefaultGateway="192.168.201.8" 

IPAddress="192.168.201.205" 

SubnetMask="255.255.255.0" 

[HOST_MACHINE] 

IPAddress="192.168.201.4" 

port="9300" 

[SYSTEM] 

Store="50" 

 

    2、修改完成后保存这个文件并复制到 U 盘上面，然后将 U 盘接在开发套件的 USB 接

口上，上电启动英创 ARM9 嵌入式模块。 

注：1、U 盘必须为 FAT 文件系统，否则英创 ARM9 嵌入式模块无法正确读取其内容。 

2、dbginfo.txt 必须在调试之前即通过 U 盘读入到英创 ARM9 嵌入式模块中。此后

如果没有修改，则无需每次开机都重新载入。如果配置有变，则修改该文件以

后再次通过 U 盘存入英创 ARM9 嵌入式模块即可。 

 

3、开机后英创 ARM9 嵌入式模块会读取 U 盘的内容，用户可以看见 U 盘上的指示灯

闪动。读取完毕（即 U 盘上的指示灯停止闪动）以后，在开发主机上启动 eVC，然后选择

Tools->Configure Platform Manager…，如图 3-16。 



英创信息技术有限公司                                    英创嵌入式模块 EM9260 使用必读 V1.01 

www.emtronix.com                                                              028-86180660 20

 
图 3-16  配置软件环境 

 

4、在打开的对话框中选择目标设备（如：EM9260 Device），然后选择右边的

Properties…，如图 3-17。 

 

图 3-17  修改英创 ARM9 嵌入式模块的配置 
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5、在 Device Properties 对话框的 Transpor 中选择 TCP/IP Transport for Windows 

CE，在 Startup 中选择 Manual Server，然后选择 Transpor 右边的 Configure…，如图 3-18。 

 

图 3-18  选择要修改的属性 

 

6、勾选 Fixed port，并在其右边的 Port number 中输入 9300。然后在 Use fixed address

右边选择开发主机的 IP 地址，如图 3-19。 

 

图 3-19  配置网络端口和开发主机的 IP 地址 
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7、连续选择 OK，关掉三个对话框。然后选择 Tools->Remote File Viewer(WCE500)，

如图 3-20 所示。 

 
图 3-20  选择 Remote File Viewer 

 

8、在弹出的对话框中选择目标设备（如：EM9260 Device），如图 3-21 所示。 

 

图 3-21  选择英创 ARM9 嵌入式模块 Device 
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9、选择 OK 确认弹出的信息，系统开始与英创 ARM9 嵌入式模块建立连接，如图 3-22。 

 
图 3-22  开发主机与英创 ARM9 嵌入式模块建立连接 

 

10、连接建立以后，将显示出当前英创 ARM9 嵌入式模块的文件信息，如图 3-23。至

此，软件开发环境安装配置完成。 

 

图 3-23  连接成功，主机端显示出的英创 ARM9 嵌入式模块当前文件信息 
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4  eVC 应用程序开发简介 

 

建立好英创 ARM9 嵌入式模块所需的硬、软件开发环境，并利用以太网将开发主机和

英创 ARM9 嵌入式模块连接成功以后，用户就可以通过 eVC 开发、调试自己所需的应用程

序了。 

eVC 开发环境和普通的 VC 非常相似，客户可以通过市面上很常见的大量 VC 书籍资料

来进行编程方面的学习。然而，使用 eVC 开发和 VC 的最大区别之一在于 VC 开发的程序

直接运行于普通 PC 机；eVC 开发的应用程序最终要在目标机而非 PC 机上运行调试。这一

过程是广大 VC 程序员和刚接触嵌入式系统的工程师所不熟悉的。因此，本章将先介绍 eVC

的程序的基本创建方法以及在运行模式下直接运行已有应用程序的方法，然后再通过三个简

单的应用程序实例来介绍如何使用 eVC 开发并在目标机上使用调试模式和运行模式运行程

序，客户可通过这三个程序熟悉 EM9260 的编程方式以及各个接口的使用，包括 LCD 显示

接口、串口、以太网口以及数字 IO 口等。 

 

4.1  创建 eVC 程序 

1、EM9260 正常启动以后的显示画面如图 4-1 所示。 

 

图 4-1  英创 ARM9 嵌入式模块正常启动以后的显示画面 
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2、启动 eVC，选择 File->New…，如图 4-2 所示。 

 

图 4-2  在 eVC 中新建 

 

3、在 Projects 选项卡中选择 WCE Application，并在右边 Project name 中输入工程

名字 hello，在 Location 中指定该工程的存储位置，如图 4-3 所示。 

 

图 4-3  新建工程 
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4、接下来的对话框中选择 A simple Windows CE application.，如图 4-4 所示。然后

选择 Finish，并选择 OK 确认弹出的工程信息对话框，工程 hello 即建立完毕。 

 

图 4-4  选择工程类型 

 

5、eVC 的文件管理、编辑方式和 VC 一样。图 4-5 所示是 hello 中的文件。 

 

图 4-5  工程 hello 中的文件 
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6、当应用程序生成后。点击右上角工具栏中的红色感叹号（也可以通过菜单栏的

Build->Execute 或者通过快捷方式 Ctrl+F5 执行该命令），如图 4-6 所示，并连续选择 OK

以确认弹出的对话框，工程开始编译执行。 

 

图 4-6  编译运行 hello 

 

4.2  在运行模式下运行程序 

1、选择 Tools->Remote File Viewer(WCE500)，连接建立以后，打开“EM9260 

Device/NandFLASH”，如图 4-7 所示。 

 

图 4-7  EM9260 NandFLASH 目录中的文件 

 

2、打开“SOFTWARE/config”目录，将里面的 userinfo.txt 复制到本地硬盘，并根

据用户所在的网络修改其内容（关于这个文件的说明见第二章）。 

以笔者的开发环境为例。本地网关为 192.168.201.8；子网掩码为 255.255.255.0；为

英创 ARM9 嵌入式模块分配的 IP 地址为 192.168.201.205 ；要运行的文件是

STEP1_LCD.exe；无参数。 

则 userinfo.txt 文件的内容应编辑如下： 

[LOCAL_MACHINE] 

DefaultGateway="192.168.201.8" 
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IPAddress="192.168.201.205" 

SubnetMask="255.255.255.0" 

[USER_EXE] 

Name="\NandFLASH\STEP1_LCD.exe" 

Parameters="" 

[SYSTEM] 

Store="50" 

注：userinfo.txt 仅仅是在需要系统工作于运行模式的时候才编辑并上传至英创模块中。

如果系统工作于调试模式，则无需这个文件。同时，该文件中的网络参数在很多情

况下与 dbginfo.txt 中的并不一样，要根据系统的实际工作环境设置。 

 

3、点击右上方工具栏中的黄色向上箭头（也可以通过菜单栏的 File->Export File 执行

该命令），如图 4-8 所示，在弹出的对话框中选择刚才编辑好的 userinfo.txt，确认，将其

复制到英创模块中（此例中 STEP1_LCD.exe 已经复制到了“NandFLASH”目录中，因此

无需再次复制。如果用户的指定应用程序此时不在“NandFLASH”目录中，则必须使用同

样的方法复制进去）。 

 

图 4-8  下载 userinfo.txt 

 

4、断开开发底板上的 JP1，重启系统，开机以后系统自动执行程序 STEP1_LCD.exe，

显示画面如图 4-9 所示。则在运行模式下运行应用程序成功。 

 

图 4-9  运行程序后 LCD 显示画面 
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4.3  STEP1 

   STEP1_LCD 是用于测试 LCD 显示程序。当用户正确安装了 EM9260 的 SDK 后，包

括 LCD_API.LIB 在内的库文件已安装到开发主机的相应目录下。操作 LCD 显示的各个接口

函数定义在 LCD_API.H 中，请客户参考该文件了解各个接口函数的定义。具体各个函数的

实现是包含在 LCD_API.LIB 中，因此在程序中如果用到 LCD 显示，需要在 PRJ 文件中 Link

该 LIB 库。设置如下： 

 

 

STEP1_LCD 主要代码如下： 

 // initialize LCD 

 type = LCD_Init( LCD_AUTO ); 

//type = LCD_Init( LCD_12864 ); 

 //type = LCD_Init( LCD_240128 ); 

 //type = LCD_Init( LCD_320240 ); 

 if( type<0 ) return -1; 

 

 MaxX = LCD_GetMaxX( ); 

 MaxY = LCD_GetMaxY( ); 
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 RowNum = MaxY/16; 

 RowStart = ( RowNum - 4 )/2; 

 RowIdx = RowStart; 

  

 // show chinese char at center position 

 strcpy( BufStr, "** 欢迎测试 **" ); 

 x = (MaxX-strlen(BufStr)*8)/2; 

 y = RowIdx*16;; 

 LCD_WriteString( x, y, BufStr, 1 ); 

 RowIdx++; 

 

 strcpy( BufStr, "嵌入式网络模块" ); 

 x = (MaxX-strlen(BufStr)*8)/2; 

 y = RowIdx*16; 

 LCD_WriteString( x, y, BufStr, 0 ); 

 RowIdx++; 

 

 // draw lines 

 LCD_DrawLine( 0, RowIdx*16, MaxX-1, RowIdx*16, 1 ); 

 RowIdx++; 

 LCD_DrawLine( 0, RowIdx*16, MaxX-1, RowIdx*16, 1 ); 

 

 // draw curve 

 for( x=0; x<MaxX-1; x++ ) 

 { 

  y = (RowIdx*16-8) - 8.0*sin( 2.0*M_PI*x/24.0 ); 

  LCD_PutPixel( x, y, 1 ); 

 } 

 

 for( x=0; x<MaxX-1; x++ ) 
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 { 

  y = (RowIdx*16-8) - 8.0*sin( 2.0*M_PI*x/24.0 ); 

  LCD_PutPixel( x, y, 0 ); 

 } 

 

 LCD_FillBar( 0, RowIdx*16, MaxX-1, (RowIdx+1)*16, 1 ); 

 LCD_FillBar( 0, RowIdx*16, MaxX-1, (RowIdx+1)*16, 0 ); 

 

 Sleep( 1000 ); 

 LCD_Clearup( ); 

 LCD_DeInit( ); 

 

4.4  STEP2 

   程序 STEP2_Serialtest 主要功能为串口测试，当程序从指定串口接收到数据时，将立

即把接收的数据反发回去。同时还利用 EM9260 提供的 GPIO 实现了一个 3X3 的矩阵键盘，

以便于程序可以通过操作按键来退出，如果接上 LCD，可以通过显示串口接收、发送的数

据长度、以及矩阵键盘的键码值。 

对于 EM9260 的 ISA 总线以及 GPIO 的操作函数均定义在 EM9260_ISA_DIO.h 中，客

户可参考该文件了解各个函数的定义。具体的函数实现包含在 EM9260_ISA_DIO.LIB 中，

和STEP1一样的，STEP2中也有用到了 LCD显示，同时STEP2还使用了EM9260的GPIO

功能，因此在 PRJ 文件中需要同时链接 LCD_API.LIB 和 EM9260_ISA_DIO.LIB，如下图

所示： 
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  STEP2 串口测试程序使用 EM9260 的 COM3 口，所以在运行程序前需要把 COM3 口

与通讯的另一端，通常可使用调试主机 PC 的串口接好。然后在 EM9260 板卡上运行

step2_serialtest 程序。在 PC 机上运行“串口调试助手”程序或者 Windows 的“超级终端”

程序，“串口调试助手”程序在开发光盘的“测试工具”目录下。然后选择好串口通讯参数：

9600 波特率、1 个停止位、8 个数据位、无奇偶校验，再点击发送。如果 EM9260 串口工

作正常，EM9260 的 LCD 上将显示接收数据和发送数据的长度，PC 机这端将看到 EM9260

反发回来的数据。EM9260 在运行测试过程中可以响应按键，并将按键的键码值显示在 LCD

上，如果按键为【KIN0 - KOUT0】短接，STEP2_serialtest 程序将退出。 

 

4.5  STEP3 

STEP3_tcptest 主要侧重于以太网络测试，该程序的功能是建立一个基于 TCP 的服务

器，侦听 TCP 的连接，如果连接建立，将处理连接接收到的数据，可以响应实时时钟的设

置或读取操作命令，对于其他的数据将直接发回给客户端。为了测试方便和 STEP2 一样，

在该程序中也加入了 LCD 显示以及矩阵键盘的操作，因此 STEP3 的 PRJ 的设置和 STEP2

一样。 

STEP3 程序进行测试时，首先在 EM9260 板卡上运行该程序，然后在 PC 机上运行

tcptest.exe，tcptest 程序包含在开发光盘中“测试工具”目录下。在对话框中，选择“客户

机”，在“服务器名称”栏目中填入为 EM9260 的 IP 地址（如：192.168.201.175），然后
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点击“连接”。TCP 连接一旦建立，原灰化的消息框将被激活，填入字符串点击发送后，数

据将发送到嵌入式模块，如果在消息框中，若不填入如何字符串，直接点击发送，tcptest

将发送设置实时时钟的命令以及 PC 机的系统时间到 EM9260，EM9260 收到后，将该系统

时间设置 EM9260 的实时时钟；如果在消息框中，填入字符“Time”，点击发送后，嵌入式

模块收到该命令后，将读取 EM9260 上的实时时钟，生成相应的串返回到测试 PC。如果消

息框中填入其他的数据，EM9260 收到数据后，会将数据直接返回到测试 PC。同 STEP2

一样的，运行测试过程中可以响应按键，并将按键的键码值显示在LCD上，如果按键为【KIN0 

- KOUT0】短接，STEP3_tcptest 程序将退出。 

 

 


